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1 Introduction

This guide describes the procedures to install and uninstall the HP OpenVMS HTTPS Operations
Manager Agents software. It also describes how to compile and link application program using
Operations Agent Message and Monitor APIs.

1.1 Verifying the Prerequisites on an OpenVMS System

To verify the prerequisites on an OpenVMS system, follow these steps:

HP Operations Manager HTTPS Agents and Smart Plug-In (SPI) software is now available on
OpenVMS Alpha Version 7.3-2, 8.2, 8.3, and OpenVMS Integrity servers Version 8.2-1, 8.3, and
8.3-1H1. Ensure that the following OpenVMS patches have been applied:

For OpenVMS Alpha:

¢ OpenVMS Alpha Version 7.3-2
— VMS732 _SYS V8.0 or later
— VMS732 PTHREAD V3.0 or later
— VMS732 UPDATE V5.0 or later
— VMS732 RPC V4.0 or later

¢ OpenVMS Alpha Version 8.2
— VMS82A UPDATE V7.0 or later
— VMS82A SYS V7.0 or later

¢ OpenVMS Alpha Version 8.3
— VMS83A_UPDATE V3.0 or later

For OpenVMS Integrity servers:
¢ OpenVMS Integrity servers Version 8.2-1
— VMS821I UPDATE V5.0 or later
— HP I64VMS VMS821I ICXXL V5.0 or later
¢ OpenVMS Integrity servers Version 8.3
— VMS83I UPDATE V1.0 or later
— VMS83I SYS V1.0 or later
— HP I64VMS VMS83I ICXXL V5.0 or later
¢ OpenVMS Integrity servers Version 8.3-1H1
— HP I64VMS VMS831H1I ICXXL V2.0 or later

The patches are available at the HP ITRC web address:
http://www?2.itrc.hp.com/service/patch/mainPage.do
You need to install the HP Operations Manager HTTPS Agents and SPI software on ODS-5 disk.
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NOTE:

Process Software’s MultiNet and TCPWare are currently NOT supported by the HTTPS
Operations Manager Agents for OpenVMS.

Remote installation of Agents fail if previous kits of Operations Manager Agents exist in
the SYS$UPDATE directory.

If install or uninstall fails due to some reason, a cleanup operation has to be done as follows
on the OpenVMS node before starting remote installation again:

— Execute the command @sysSupdate:opc_inst -c
— Stop any Agent or VMSSPI processes

— Delete node specific directory (OVO$<NodeName>) and common directory
(OVOSCOMMON _ALPHA or VOSCOMMON IA64)

— Delete the lock file SYS$SYSTEM : LOCK . LCK, if it exists.

While doing remote installation or uninstallation on nodes especially in homogenous clusters,
the Management Server console may appear to be hanging at times. This is a normal behavior.

If you want to upgrade to OpenVMS HTTPS Operations Manager Agents V8.6 from previous
version, the kit will be installed in the same disk, where the previous kit was installed
irrespective of the disk name provided at the time of installation. Also, the policies are to
be redeployed from the management server as new certificates are deployed during upgrade.

If Management Server is configured not to grant certificates automatically, remote installation
of Agents will result in a pending certificate request. You need to grant manually from the
certificate request window on the Management Server and Agents must be restarted on the
managed node subsequently.

If installation or upgradation results in a failure message on the Management Server console,
itis required to check the PCSI database on the OpenVMS node for confirmation. Sometimes
it shows a failure message even if the Agents are installed successfully.

Make sure you have REXEC, RSH, and FTP services enabled on the remote agent (HTTPS-based)
before you start the HPOM agent installation. Otherwise the agent installation will fail. Make
sure that the SNMP agent is running before adding a managed node to the HPOM database.

1.2 Installing HPOM Software on the Managed Node
1.2.1 Management server is Operations Manager for (OMU 8.3x)

1.2.1.1 Configuration on the Management Server

6
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Download OpenVMS-0OA-8.6.030C. tar from the web to a directory (say /temp ) on the
Management Server and untar it by logging into the management server as ‘root” user.

# cd /temp
# tar -xvf OpenVMS-OA-8.6.030C.tar

Execute the following script. This script performs the required validations on the management
server.

# cd /temp/OVMS8.60
# ./OA-setup.sh
You can use ‘-h” option with ‘OA-setup.sh’ for help.

To add a node, click Actions and select Node in the Node Group window.

Click Add. The ADD Node window is displayed. Enter the label and hostname as shown
in the following figure and click OK.
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‘ Add Node

If OpenVMS OS policies are not available on the management server, then download
ovmspolicies_u.tar for OMU from the web to a directory on the management server.
Execute the following steps as ‘root” user for uploading the OpenVMS policies to OMU 8.3x
Management Servers:

a. Take a backup of previously existing OpenVMS policies, if any, on the management
server as follows:

1) In the OVO Node Bank window, go to Window Menu -> Message source
templates.

2) Select the Template Group, which has to be backed up.
3) Click Modify.
4) Change the Template Group Name in the Modify Template Group window.

b. FTP ovmspolicies_u.tar to the OMU Management Server in binary mode.

¢. On the OMU Management Server, change directory to the location where
ovmspolicies u.tar file exists.

RUN tar -xvf ./ovmspolicies u.tar.

e. RUN ./ovmspol-setup.sh. This uploads the policies to the OMU management
server.
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1.2.1.2 Remote Installation
Execute the following steps on the Management Server after logging in as ‘root’ user.

1. To install or update the software and configuration, click Actions and select Agents in the
Node Group window.

If it is a new node, add the managed node to the Management Server.

2. Click Agent/Install SW & Config. The Install/Update OVO Software and Configuration
screen appears.

3. Select Agent Software and click OK.
4. Enter the system password of the managed node to continue the installation.

5. Enter one of the ODS-5 disks listed on the screen when prompted.
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6. After you provide the disk name, it downloads the packages to the node and it prompts you
to enter the ODS-5 disk name where the Openview agents will be installed.

7.  After entering the disk name again, the installation starts. After the installation is complete,
successful installation screen is displayed.

8. After the installation completes, check whether ovcoreid of the node is registered in the
management server.
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9. Login into the OpenVMS agent and check whether all the process are running.

S ove

ovcd OV Control CORE (1135) Running
ovbbccbhb OV Communication Broker CORE (1136) Running
opcacta OVO Action Agent AGENT, EA (1138) Running
opcle OVO Logfile Encapsulator AGENT, EA (1140) Running
opcmona OVO Monitor Agent AGENT, EA (1141) Running
opcmsga OVO Message Agent AGENT, EA (1137) Running
opcmsgi OVO Message Interceptor AGENT, EA (1142) Running
ovconfd OV Config and Deploy COREXT (1139) Running
$

1.2.1.3 Manual Installation

See the Manual Installation section for “Management Server is Operations Manager for Windows
(OMW 8.x)” (page 10).

1.2.2 Management Server is Operations Manager for Windows (OMW 8 .x)

1.2.2.1 Contiguration on the Management Server

1. Download OpenVMS-0A-8.6.030C. tar from the web to a directory (say c:\temp ) on the
Management Server and unzip the tar file using WINZIP by logging into the management
server as ‘Administrator’.

2. Execute the following batch file. This performs the required validations on the management
server and copies the agent packages.

cd c:\temp

c:\temp\OVMS8.60\OA-setup.bat

The agent packages for OpenVMS are copied to the following directories.
For OpenVMS on Alpha:
$0vShareDir%Packages\HTTPS\openvms\hp\7.3.2 8.2.0
8.3.0\alpha\Operations-agent\08.60.030C\64\https

For OpenVMS on Integrity servers:
$0vShareDir%Packages\HTTPS\openvms\hp\8.2.1 8.3.0
8.3.1\ipf64\Operations-agent\08.060.030C\64\https

3. Toadd anode, right-click on Nodes on the left pane of HP Operations Manager console and
select Configure -> Nodes....
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4.

Window  Help
T

Severity i Duplicates i 5 j 0] i 1 i A i Oi il j Received + i Created
/2 Minar - d - - - - 48f2010 12:Z313PM 4f5j2010 12:2
T Eifters... 1 S - .- o - 4fgl2010 230:2TPM 4902010 1:07
1 S - .o .- 4fal2010 HISOLPM 482010 247
e 1 - - - - - - 4/g/2010 3:16:50PM 41g/2010 311
i N Service Types... 2 - - ® - - - 4/gf2010 3:24:49PM 41812010 305
S e Services... 2 - - ® - - - 4/g/2010 32456 PM 41812010 305
S 4 - - ® - - - 4/g/2010 3:25:04 PM 41812010 305
Hew Taskpad Yiew... e R - - - - - - 4f5[2010 F2TAIPM 482010 327
5 — S W o- - - - 4/8/2010 &:31:21 PM 4/5/2010 5:02

Properties

T Mormal - - - - - - 4/8/2010 8:31:36PM  4/5/2010 5:02
Help T Mormal - - - - - - 4/8/2010 &:31:37PM 4/5/2010 5:02
% Mormal - - - - - - 4/8/2010 &:31:37PM 4/5/2010 5:02
€3 Critical S .- oo - 4/8/2010 8:31:41PM 45/2010 5:02
€3 Critical S .- oo - 4/8/2010 S:31:41PM 4/5/2010 5:02
€3 Critical S .- oo - 4/8/2010 S:31:41PM 4/5/2010 5:02
€3 Critical S .- oo - 4/8/2010 S:31:41PM 4/5/2010 5:02
€3 Critical S .- oo - 4/8/2010 S:31:41PM 4/5/2010 5:02
/8, Minor S .- oo - 4/8/2010 S:31:41PM 4/5/2010 5:02
 Major S .- oo - 4/8/2010 S:31:41PM 4/5/2010 5:02
€3 Critical .- - - .- 4/8/2010 B:31:41PM 4/5/2010 5:02
£3 Critical - - - - - - a4fafz0i0 B:ELA1IPM 48i2010 502
/& Minor .- - - .- 4/8/2010 B:3T46PM 4/5/2010 5:08
€3 Critical - - - - - - a4fof0i0 30013 AM  49)2010 300
£3 Critical - - - - oW 4117010 1Z:50:43 AM 4112010 125
Ecrtical & - - - - - - 4112010 11:58:41 AM 48i2010 347
F Major .- - - .- 4/11j2010 121243 FM 4112010 12:
£ Warning - - ¥ - - - 4/11j2010 1212145 FM 4112010 12:
£, warning - - ¥ - - - 4/11j2010 12135 PM 4112010 12:
£ warning - - ¥ - - - 4/11j2010 1Z:15:44 PM 4112010 12:

In the Configure Managed Nodes window, right-click on Managed Nodes and select New
Node.

g- OMW10: Configure Managed Nodes

Click on the node in the Discovered Modes tree, drag it to the Managed Mades tree, and drop it j:_j
over the Folder wou want to add ik to,

OR

Select the folder in the Managed Mades tree, right-click to open the conkext menu, then choose

Mew MNode, :;j

C- =] Discovered Modes =-is) i
[+ Eﬁ DS &+ Few Mode

=+ EE! Microsoft Windows MNebwork @ Mew External Mode
&8 Unmanaged Nodes with Agents ] Mew MNode Group

Find...
Fename:
Properties

(0] 4 Cancel
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5. Inthe Base Settings window, provide OpenVMS node name and select the option Enter
Manually under OS Version Information.

Base Settings

Full Qualified Damain Mame: abc,xyz.com

Display name: abc

05 Yersion Infarmatiaon

" Use discovery service

....................................

................................................................................................

6. Provide the OpenVMS system details and click Finish.
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b e —

Syskem Type: (Required) 1Itanium Compatible :__j
Qperating Swskem: (Required) 1Dpen'u'r~'15 __‘_"_"__j
Bit Length: |64 =l

verson: (Requred) s

Expert Mode i

= Barck Mext = Finish Zancel Help

Uncheck all the check-boxes on the Agent Installation window and click OK.

!! Agent Installation [ _ (O] x|

St the credentials for every noda where an agent should be instalied. Setting credentials can be done using the right
mause click on & node or clicking the credentals Ffeld,

‘De_plﬁ;?\] Name + | Comm Type | 05 Type | Prereq Check | Cradentials |
A | midas HTTPS OpeniMs B Urknown rucfie

S

-

L J | (54 E Cancel Help

If OpenVMS OS policies are not available on the management server, then download
ovmspolicies w.tar for OMW from the web to a directory on the management server.
Execute the following steps as ‘Administrator” for uploading the OpenVMS policies to OMW
8.x Management Servers:
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a. Download ovmspolicies w.tar tothe OMW Management Server.

b. On the OMW Management Server, change directory to the location where
ovmspolicies w.tar file exists.

¢. Unzip ovmspolicies_ w.tar using winzip.

In the management console, under Policy management ->Policy groups, rename
OpenVMS_policies and OpenVMS_SPI_policies groups. Uploading new policies
overwrites the modified policies, if any.

e. Execute ovmspol-setup.bat. This takes a backup of existing OpenVMS policies and
uploads the new policies to the OMW management server.

1.2.2.2 Remote Installation

Remote installation is not supported when the management server is Operations Manager for
Windows (OMW 8.x).

1.2.2.3 Manual Installation

1. Download OpenVMS-0OA-8.6.030C. tar from the web to a temporary directory on the
OpenVMS Managed Node and untar it by logging into managed node as ‘'SYSTEM'. If tar
utility is not available on the OpenVMS node, then download VMSTAR.ALPHA_EXE (for
Alpha) or VMSTAR.IA64_EXE (for Integrity server) from the web.

Execute the following commands to untar:

$ set proc/par=ext

$ tar :==$[<temporary directory>]:VMSTAR.IA64 EXE (For Integrity servers)
Or
$ tar :==$[<temporary directory>]:VMSTAR.ALPHA EXE (For Alpha)

$ tar -xvf OpenVMS-OA-8".6".030C.tar
This untars the files in the OVMS8_60 directory under the temporary directory.

2. Change directory to OVMSS8_60 and execute the script OA SETUP.COM as ‘SYSTEM:
$ @OA-SETUP.COM -1 -srv <<management server>> -cert srv <<certificate servers>>
For example,
$ @OA-SETUP.COM -1 -srv abc.def.hp.com -cert srv ghi.jkl.hp.com
3. Provide the ODS-5 disk details when prompted for installation disk. The installation of
agents starts.
4. To check if the agents are installed successfully, execute the following commands:

$PRODUCT SHOW PRODUCT OV*,VMSSPI

Sovc —-status

Sovcert -list

The output of the commands must be as follows:

$SPRODUCT SHOW PRODUCT OV*, VMSSPI

PRODUCT KIT TYPE STATE

HP I64VMS OVBBC V8.6-1 Full LP Installed
HP I64VMS OVCONF V8.6-1 Full LP Installed
HP I64VMS OVCTRL V8.6-1 Full LP Installed
HP I64VMS OVDEPL V8.6-1 Full LP Installed
HP I64VMS OVEAAGT V8.6-1 Full LP Installed
HP I64VMS OVSECCC V8.6-1 Full LP Installed
HP I64VMS OVSECCO V8.6-1 Full LP Installed
HP I64VMS OVXPL V8.6-1 Full LP Installed
HP I64VMS VMSSPI V8.6-1 Full LP Installed

9 items found
Sove -status
oved OV Control CORE (95D) Running
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opcacta OVO Action Agent AGENT, EA (960) Running
opcle OVO Logfile Encapsulator AGENT, EA (963) Running
opcmona OVO Monitor Agent AGENT, EA (964) Running
opcmsga OVO Message Agent AGENT, EA (95F) Running
opcmsgi OVO Message Interceptor AGENT, EA (965) Running
ovbbccb OV Communication Broker CORE (95E) Running
ovconfd OV Config and Deploy COREXT (961) Running

Sovcert -list

e e +
| Keystore Content |
et i +
| Certificates: |
e e +
| Trusted Certificates: |
e et +

Login to the Windows Management Server to check whether a certificate request has been
received for the OpenVMS node. Note that this certificate request is automatically initiated
as part of installation.

[T HP Operations Manager - [Dperations Manager : DMW10'Certificate requests]

[ff Fle Action Yiew Favortes ‘Window Help | ==l
& = | B ] |

[if3 Operations Manager : QMWD Request State | Mapped Mads | Requesting Client [P address [0S Type 1 05 version [ System Type | Received
B services &2 Node not mapped ALETHA 15.146.239,174 0.0.0 IPF 4122010 1Z:44:49 PM
) il Modes

& £ Tooks

%)) Certificate requests

g Policy management

- Palicy aroups

Hierarchical Mode Groups

HPOI Self Management

Microsoft Windows

OperMS_policies
OpenttMs_policies_okd

[0 OpentMs_policies_oraupldbyserver
OpenitMS_5PI_policies
OpentMS_5PI_palices_old
OpenitMS_sPI_policies_orgupldbyserve,

Service Reports Maintenance
4 SPI for Unix 05

-3 Agent policies grouped by type
1[5 Server policies grouped by type
& Deplovment packages

3 Deployment jobs

If the certificate request for the OpenVMS node is not listed, login to the OpenVMS node as
SYSTEM and execute the following commands to initiate a certificate request:

S@SYS$SSTARTUP: OVO8SDEFINE

Sovcert -certreq

Map the certificate request to the OpenVMS node on the Windows Management Server.
Open the Certificate request window.

To map the certificate request, right-click on the certificate request, select All Tasks -> Map
to Node...

[T HP Operations Manager - [Dperations Manager : DMW10'Certificate requests]

[ Ele Acton Wew Favortes Window Help o |
+ = BE ® |

i3 Operations Manager : OMW/10
) BE services
5 fig Modes Al Tasks
-l HP Defined Groups T
S detha s 25 Sul
3 alex Help
- oMW10 (Management Server) T
& £ Tooks
%)) Certificate requests
2 g Policy management
-5 Palicy groups
[ Agent policies grouped by type
- Server policies grouped by type
&l Deployment packages
%3 Deployment jobs

Mapped hode

Request Skats 05 Yersion

4/6/2010 7:05:
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7. Inthe Map Certificate Request to Node window, select the OpenVMS node and click the
Map Node button.

& Map Certificate Request to Node

Select the node to which the zelected certificate request should get
mapped to:

+- E,_E.'} HP Defined Groups
B aletha
=]
S alex
=1 .
. Qemini
B midas
QMW 0 {Management Server)

=

B triton

Cancel 1

g

Following warning message pops up. Click Yes to proceed.
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9.

E

Select the node to which the selected certificate request thould get
mapped to:

,'=.,',1 HP Defined Groups

g; aletha
% alex

@ QM 10 {Management Server)

Warning 1
"j (OY-C5I 4920 Warning: The node name in the certificate request and the name of the selected node are different!
Mapping the these bwo could cause communication problems.

Do wou skill want ko proceed?

tap Node Cancel

4

The request state changes to Needs granting. Right-click on the certificate request. Then,
select All Tasks -> Grant to grant certificate.

F= HP Dperations Manager - [Dperations Manager : OMW 10", Certificate requests]

File  Action  Wiew Favorites  Window  Help
& = | BH
Lﬁ Operations Manager : MW 10

% Services

Request State Mapped Mode Requesting Clisnk

e s
w-fg HP oefined Growps ~ Deny

& aletha P[upertles _ Discard
alex Help
[+ CMW10 (Management Server)
@ Tools
%) Certificate requests
d Palicy management

f- =8 Policy groups
ﬁ agent policies grouped by type
* ﬁ Server policies grouped by bype
E@ Deplovment packages
iﬁg Deplovment jobs

Urmap

On the OpenVMS node, verify that certificate is granted and then restart agents.
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TELNET (aletha.ind.hp.com) - PowerTerm 525

opcactivate successful ly ended.
Starting opcactivate utility,

opcactivate script will use &the valu
Qv Server hostname: OFH18 ASTARPACIELG
Lertificate Server hosiname: OHM € RARACIELG,

O¥0 Agenis installed SUCCESSFULLYI

cart =list

ey

i

=3ovc ~kill

-3

=rove =ciart

>

=3gve ~status

ave a¥ Control CORE (4EB ) Running

apcacta O¥0 Action Agent AGENT ER { Running

apcle a¥0 Logfile Encapsulator AGENT B/ (4EC) Running

apcmona O¥0 Honitor fAgent AGENT ER (4 Running
O¥0 Heseage Agent AGENT ER (4Ed ) Runin g
ava He e Interceptor AGENT .EA (4 Running
Qv Communication Broker (AE7 ) Running

aveonfd 8¥ Config and Deplay (4EA) Running

o

1.2.3 Management Server is Operations Manager for UNIX (OMU 9.x and OML

9.x)

1.2.3.1 Configuration on the Management Server

18

1.

E,%

Download OpenVMS-0A-8.6.030C. tar from the web to a directory (say /temp ) on the
Management Server and untar it by logging into the management server as ‘root” user.

# cd /temp
# tar —-xvf OpenVMS-OA-8.6.030C.tar

Execute the following script. This script performs the required validations on the management
server.

# cd /temp/OVMS8.60
# ./OA-setup.sh
You can use ‘-h’ option with ‘OA-setup.sh’ for help.

If the Management Server is OML 9.x, execute the following command to register OpenVMS
machine types:

NOTE: This step is not applicable for OMU 9.x (HP-UX and Solaris).

# cd /opt/OV/OMU/adminUI

./adminui ant -f run.xml intern.init ovomachtype

#
# ./adminui machtypes
# ./adminui clean

#

./adminui start
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If OpenVMS OS policies are not available on the management server, then download
ovmspolicies u9.tar for OMU9 from the web to a directory on the management server.
Execute the following steps as ‘root” user for uploading the OpenVMS policies to OMU 9.x
Management Servers:

a. FTPovmspolicies u9.tar to the OMU 9.x Management Server in binary mode.

b. On the OMU9 Management Server, change directory to the location where
ovmspolicies u9.tar file exists.

¢. Runtar -xvf ./ovmspolicies u9.tar.

d. If the Management Server is OMU 9.x, run. /ovmspol-setup. sh. This uploads the
policies to the OMU 9.x management server.

e. If the Management Server is OML 9.x, run chroot / ./ovmspol-setup.sh. This
uploads the policies to the OML 9.x management server.

To create OpenVMS node group, follow these steps:

a. Inthe Operations Manager Administration Ul window, go to Edit ->Add Node Group.

Operations
D Manage

n Ul

Add Node Group
Add Node Hierarchy
Add Layout Group

Add Message Group
Add Policy

Add Policy Group
Add Category

Add Tool

Add Tool Group

Add User

Add User Profile

Add Regroup Condition

b. The Add Node Group screen appears. Enter the Node group Name as OpenVMS and
click Save.

1.2 Installing HPOM Software on the Managed Node 19



Operations !
Eﬂ Manager ﬁ @ i X @ . ’ V))!

OMuU Server Admin
Administration Ul

Add Node Group

Properties

s

Labe CpenviS

Description BoenViis

nfprmanen C:e"u"'&{

[ Hice tioge Group from Responsiities

Fiease do not use the browser BACK button, whil editing. To quit the editor, use the CANCEL button

S

6. To add the OpenVMS Managed Node to the Management Server, follow these steps:
If the Management Server is OMU 9.x (HP-UX or Solaris):

a. Add the Alpha managed node or Integrity servers managed node to the Management
Server, execute the following commands from the command line.

On Alpha managed node:

/opt/0V/bin/OpC/utils/opcnode -add node node name=<node name>
node label=<nodelabel> group name=0OpenVMS net type=NETWORK IP
mach type=MACH BBC VMS ALPHA

For example:

/opt/0V/bin/OpC/utils/opcnode -add node node name=nodel.xyz.com
node label=nodel group name=OpenVMS net type=NETWORK IP
mach type=MACH BBC VMS ALPHA

On Integrity servers managed node:

/opt/OV/bin/OpC/utils/opcnode -add_node node_name=<node_name>
node_label=<nodelabel> group_name=OpenVMS net_type=NETWORK_IP
mach_type=MACH_BBC_VMS_IPF64

For example:

/opt/0OV/bin/OpC/utils/opcnode -add node node name=node2.xyz.com
node label=Alex group name=0OpenVMS net type=NETWORK IP
mach type=MACH BBC VMS IPF64

If the Management Server is OML 9.x:
a. Inthe Operations Manager Administration Ul window, go to Edit ->Add Node.
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b.

C.

Operations -,
(D ] Manager ﬁ @

oMU
nistration Ul

tdit -  Browse~ Server Configuration~ Find> Analyse~ Deploymeni~ Tasks~w
Add Node

Add Node Group

Add Node Hierarchy

Add Layout Group

Add Message Group

Add Policy

Add Policy Group

Add Category

Add Tool

Add Tool Group

Add User

Add User Profile

Add Regroup Condition

Agd instruction Text interface

The Add Node screen appears. Select the Node type as IP Network -> HP Alpha
(HTTPS) -> HP-OpenVMS for Alpha managed nodes and IP Network ->
Itaniumé64/32 (HTTPS) -> HP-OpenVMS for Integrity servers managed nodes.

Operations
U3 va ager

Tasks~ Integrations

Add Node

Properties

Node type:

Please ¢ fhe editor, use the CANCEL button.

Messages

Version: 9.0.1

non 1P > athar > sther

Enter the Managed Node Host name and Label as shown in the following figure and
click Save.

Add Node
Properties [ Advanced |
Node type: | IF Network -> HF Alpha(HTTFS) > HP-OpenVMS v/

Hest name krones.ind hp.com ‘

Label irones |-
P Address 1514822588 W+

[ system acguires P dynamically (DHCP)

Information

Parent Group Q
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1.2.3.2 Remote Installation

l%'_"/y NOTE: Remote installation is not supported when the management server is OMU 9.x HP-UX.

Execute the following steps when the Management Server is OML 9.x:

1. To perform remote installation of agents on a specific OpenVMS node, execute the following
perquisite script on the Management Server command line to identify the installation disk.

# cd /opt/OV/bin/OpC/agtinstall

# ./getinstdisk.sh <Node Name>

For example:

./getinstdisk.sh abc.xyz.com

When you run the script, it prompts as follows:

¢ Enter the SYSTEM password.

e Lists all the ODS-5 disks available on the Managed Node.

*  When it prompts again, enter the disk on which you want to install the agents.

*  Then, it verifies minimum disk space requirement and marks the disk to install the

agent software. When remote installation is initiated, it installs agent software on the
disk.

2. Inthe Operations Manager Administration Ul window, go to Browse —>All Nodes. This
displays all the nodes added to this management server.

Operations
@ ® @ F X @

Server Configuration > Find~ Analyse~ Depioyment~ Tasks~  Integrations~  Servers =

+ TP

: All Node Groups

P Al Hode Higrarchies
All Layout Groups
All Node Defaults
All Message Groups

= All Policies.

hl Al Policy Groups

3. Inthe All Nodes window, go to Managed Node’s Action Menu and select Install Agent...

EQILY BIOWSe~¥  >erver LONIGQUIalon~ Hna~v  Analyse~  Uepioymeni~  1asks~  NEQrauons~  >ervers~

All Nodes = - o -

Filter »
Found 4 Elements

W Type Label Hame T [ Network type Machine type

O 4§ kronos kronos.ing.hp. com v O~ 1514623988 B HP AlphaiHTTPS)

O 8 cemifecesnacen Geilelnanini InteVAMD X54(HTTPS)
0 @ tcumiiGdewhocom tevm110.dew.ho.com ItebAND xE4(HTTPS)
I trign,ind hp com Kanwum E4R2(HTTPS)
t Cheose an action ~ | ‘ Copy With Assignments...

i Assign Hode to Node Group...
& Assign Policies | Policy Groups..
e Move to layout group...

Found 4 Elements

*3 Assign Categories...

% Update Assignments...
# Execute Task...

# Install Agent...

¥ Deinstall Agent...

T Deploy Configuration...
# Install Sub-Agent...

4. The (De)Install screen appears. Select Install type as 'Installation’ and click Preinstall Check.
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Operations

(D] Manager /ﬁ\ @ i x

Administration Ui

(De)lInstall Agent i?ﬁ

Properties

nstal tyge eaiwizn v

riozes e |

rm_ &
.
pore_____________________________________________________________ |
Prese g0 not use the browser BACK button, whit editing, To qut the edeor, use the CANCEL duton
Preinstall Check

tessages

Enter the SYSTEM password for the node and click Install on selected Nodes

Operations

A Manager /ﬁ\ @ i x

Administration U

(De)Install Agent
Properties

haip
[setect _Jwodename P Adaress ____[machine Type _____[NetworkType ____[Memod _[sutus ________lcomment __[Force? _Juser _[Passwora |
krenes.ind hg.com 15.148 239 88 HP Alpha(HTTPS) L] standard ‘passwdrequred.

ok (mgre_) = L |

Fiease 4o 1ot use the browser BACK button, whi edting. To quit the edior, use the CANCEL button.

nstall on selected lodes
Vessages

precheck performediok

This installs the agent’s software on the Managed Node and displays the following message

Edit~ Browse~ Server Configuration~ Find~ Analyse - Deployment~ Tasks~ Integraions~ Servers~

All Nodes = - © -

Haip
Gperation install of node/ayout group intiated sucoessfuly.

Instalations are running asynehronously. Review
instalation takes oo long, please refer to

the status of pending insialations at the Inked gage below. Initally the inked page might be empty, if no log file has been writen yet. Please reload the linked page periodically to display progress. If the
to reduce the TMEOUT of i o

® Agent ingtallation Logs

6.

After the installation is complete, check the installation log file for remote installation status.
a.

In the Operations Administration Ul windows, go to Deployment —>Installation
Jobs.

Operations o,
(D Manager (3

- - Admin Help
Administration Ul '

Edit~ Browse~  Server Configuration~ Find ~

Deployment ~ | Tasks =

Integrations =  Servers -

Deploy Configuration...
HPOM for UNIX Configuration =~ o -

e ObjectBanks
e All Objects

ation Jobs
« Server Configuration Pending Certificate Requests
e Flexible Management Configuration
Object Banks

Object Hierarchies
H Node Bank

b. The Agent Installation Jobs screen appears. Open the node specific XML file and
check the installation status.
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Operations
(] Manager ﬁ E X

oMU
Adminisiration Ul

Editv Browsev ServerConfiguraion~ Find~ Analysev Deployment~ Tasks+ Integrations v

Agent Installation Logs
Pt OV/OMWedminUllogs/agentinstsiljobs

Details jobs v

Found 1 Elements

May 12, 2010 8:02:48 AW

I Choose an action

Found 1 Elements

7.  After the installation completes, check whether OVCOREID of the node is registered in the
management server To do so, follow these steps:

a. Inthe Operations Manager Administration Ul window, go to Browse —>All nodes.

b. Click on managed node link. The Node properties screen appears. Check the Core
ID.

Edit~ Browse= Server Configuration~ Find~ Analyse~» Deployment~ Tasks~ Integrations~ Servers=~

Node "kronos"= - © -
Afttribute Value
Harme kronos.ind.np.com
Label knonos
P agdress 15.148.239.88
Hetwark type P
Machine type HP &bha(HTTPS}
Contral type controlied
Communication type HTTPS
Heartbeat poling enabled enabled
Poliing type Normal
Agent sends alive packeis No
Heartbeat interval 0h10ms
Auto instal enabled
Auto updale enabiled
Terminal xterm
Terminal Font
MS| output disabied
WIS] abow auto action disabled
MSl alow operator intiated actions disabled
Buffer size mt disabled
Installaticn Method opc
Installation User root
o AsSCe
Core D ITdeedle-c2fe-7545-110b-8%cEbbeldbbl
Certificate State instalied

8. Login into the OpenVMS agent and check whether all the process are running.

$ ovc

oved ov Control CORE (1135) Running
obbccb ov Communication Broker CORE (1136) Running
opcacta OVO Action Agent AGENT, EA (1138) Running
opcle (e)Y/6] Logfile Encapsulator AGENT,EA (1140) Running
opcmona OVO Monitor Agent AGENT, EA (1141) Running
opcmsga OVO Message Agent AGENT, EA (1137) Running
opcmsgi OVO Message Interceptor AGENT, EA (1142) Running
ovconfd OV Config and Deploy COREXT (1139) Running

9. Check whether valid certificate is installed on the Managed Node.
Ovcert -list

Ovcert -check
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If there is no valid certificate installed, see Section 1.2.3.4 (page 26) to manually install the
certificate request from the managed node.

1.2.3.3 Manual Installation
Management server is Operations Manager for Windows (OMU 9.x and OML9.x)

1.
2.

See Section 1.2.3.1 (page 18) and complete Step 1 through Step 6.

Download OpenVMS-0OA-8.6.030C. tar from the web to a temporary directory on the
OpenVMS Managed Node and untar it by logging into managed node as ‘'SYSTEM'.

If tar utility is not available on the OpenVMS node, then download VMSTAR.ALPHA_EXE
(for Alpha) or VMSTAR.IA64_EXE (for Integrity servers) from the web.

Execute the following commands to untar:

$ set proc/par=ext

$ tar :==$[<temporary directory>]:VMSTAR.IA64 EXE (For Integrity servers)
Or
$ tar :==$[<temporary directory>]:VMSTAR.ALPHA EXE (For Alpha)

$ tar -xvf OpenVMS-OA-8".6".030C.tar
This untars the files in the OVMS8_60 directory under the temporary directory.

Change directory to OVMSS8_60 and execute the script OA SETUP.COM as ‘SYSTEM":
$ @OA-SETUP.COM -i -srv <<management server>> -cert_srv <<certificate server>>
For example,

$ @OA-SETUP.COM -1 -srv abc.def.hp.com -cert srv ghi.jkl.hp.com
Provide the ODS-5 disk details when prompted for installation disk. The installation of
agents starts.
To check if the agents are installed successfully, execute the following commands:

$PRODUCT SHOW PRODUCT OV*,VMSSPI

Sovec —-status

Sovcert -list

The output of the commands must be as follows:

$SPRODUCT SHOW PRODUCT OV*, VMSSPI

PRODUCT KIT TYPE STATE

HP I64VMS OVBBC V8.6-1 Full LP Installed
HP I64VMS OVCONF V8.6-1 Full LP Installed
HP I64VMS OVCTRL V8.6-1 Full LP Installed
HP I64VMS OVDEPL V8.6-1 Full LP Installed
HP I64VMS OVEAAGT V8.6-1 Full LP Installed
HP I64VMS OVSECCC V8.6-1 Full LP Installed
HP I64VMS OVSECCO V8.6-1 Full LP Installed
HP I64VMS OVXPL V8.6-1 Full LP Installed
HP I64VMS VMSSPI V8.6-1 Full LP Installed

9 items found
Sovc -status

oved OV Control CORE (95D) Running
opcacta OVO Action Agent AGENT, EA (960) Running
opcle OVO Logfile Encapsulator AGENT, EA (963) Running
opcmona OVO Monitor Agent AGENT, EA (964) Running
opcmsga OVO Message Agent AGENT, EA (95F) Running
opcmsgi OVO Message Interceptor AGENT, EA (965) Running
ovbbeccb OV Communication Broker CORE (95E) Running
ovconfd OV Config and Deploy COREXT (961) Running

Sovcert -list

| Certificates: |
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Login to the OMU9/OML9 Management Server to check whether a certificate request has
been received for the OpenVMS node. Note that this certificate request is automatically
initiated as part of installation.

If the certificate request for the OpenVMS node is not listed, login to the OpenVMS node as
SYSTEM and execute the following commands to initiate a certificate request:

S@SYS$SSTARTUP: OVO8SDEFINE

Sovcert -certreq

Map the certificate request to the OpenVMS node on the Management Server. To grant the
certificate see Page 26.

On the OpenVMS node, verify that certificate is granted and then restart agents.

Fie Edit Teminal Communication Options S0t Help

1.2.3.4 Manually Requesting the Certificate from the Managed Node

26

If a valid certificate is not installed on the managed node, perform the following steps to install
the certificate

1.

Login to the OpenVMS Managed Node as SYSTEM and execute the following commands
to initiate a certificate request:

$ @SYS$SSTARTUP:OVO8SDEFINE.COM

S ovcert -certreq

In the Operations Manger Administration Ul Window, go to Deployment —> Pending
Certificate Requests.
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Operations . V)
(@l Manager /ﬁ\ E x

Administration Ul
Deployment ~ ~ Tasks »  Integrations
Deploy Configuration...

HPOM for UNIX Configuration = - ¢ - Deploy Server Policies

Agent {De)installation...
Obiect Banks Insta

-

» All Objects sEER_—————————
.3 N ' Pending Certincate Requests ’
+ Flexible Management Configuration

erver Confiquratiol

Object Banks

N ank

E | Pgicy Bank

3. The Pending Certificate Requests screen appears. If the certificate request is not mapped,

select Map Force... option from the List menu to map the pending certificate request to the
Managed Node.

Operations
(D] Manager

Administration Ul

Edit~ Browse~ Server Configuration~ Find~ Analyse~ Deployment~ Tasks~

Pending Certificate Requests= - o -

Filter -
Found 1 Elements

A g c 2 £ E g L] 1 K L M il 2 B 2 B £
J B Host Time Mapped Platform IP Address

KRONOS.IND HP.COM  ©5/12/10 08:27:48 h~ O ~ kronos.ind.hp.com OpenVMS 0.0, CPU: Alpha 15.148.229.8
1 | Choose an action ~ @

Choose an action
Foun Map...

Map Force..

Grant

Version: 8.0.1

4. Select 'Add and Grant' option from the List Menu to grant the certificate. Click <<figu;re>>
button.

Operations o, _ [ Y@ S W
/23 Manager ﬁ E "};q! T’E
Administration Ul - L ;. ) -

Edit~ Browse~ Server Configuration~ Find~ Analyse~ Deployment~ Tasks~ Integrations~ Servers~-

Pending Certificate Requests = - o -

Filter =
Found 1 Elements

4 g £ 2 £ E ] L=} P S L M il 2 e [+ B H I
J B Host Time Mapped Platform IP Address
KRONOS.IND.HP.COM  0S/12/10 08:37:48 Ch~ O ~ kronos.ind.hp.com OpenVMS 0.0, CPU: Abha 15.148.239.88

t | Add and Grant @

Found 1 Elements

This grants the certificate requests and displays the following message:
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Operations A @ E

A Manager

Administration Ul

Horme oMU Server

Pending Certificate Requests

odeayout group was 53

oB$define.com

ate reguest has been successfully triggered.

1.3 Uninstalling HPOM Software from the Managed Node
1.3.1 Management server is Operations Manager for UNIX (OMU 8.3x)

To uninstall the HPOM software, follow these steps:

1. Select the Node that you want to uninstall in the Node Group window.
2. Click Actions and select Agents.
3. (Click Deinstall. The Deinstall OVO Software and Configuration screen appears.
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4. Click OK.

5. Enter the password of the managed node and the system displays product unistalled
successfully.

1.3.2 Management Server is Operations Manager for Windows (OMW 8 .x)

To uninstall operations manager for Windows, login to the OpenVMS managed node as SYSTEM
and execute the following script:

S@SYSSMANAGER : OPC_UNINST

NOTE: During the unistallation of OVO HTTPS agents, the following messages may be
displayed. These messages can be ignored:

OVO HTTPS Agents UNINSTALLED successfully!

Product UNINSTALLED successfully!

$RMS-E-FNF, file not found

$RMS-F-ISI, invalid internal stream identifier (ISI) value

$

1.3.3 Management Server is Operations Manager for UNIX (OMU 9.x or OML 9.x)

To uninstall operations manager for UNIX, follow these steps:
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1.

2.

In the Operations Manager Administration Ul window, go to Broswe -> All Nodes. This
displays all the nodes added to this management server.

In the All Nodes window, go to Managed Node’s Action Menu and select Deinstall Agent...

All Nodes = - o -

Filter v
Found 4 Elements

a g < [ £ E 8 H 11K L u N o B 2 R s I U ¥ W X X

B Type  Label Name B Machine type Control

0O -§ mones kronos ind ho com HP Apha(HTTRS) controlled

o a3 m07¢ dey hp com tcym07+4 dey o com INBVAMD xB4(HTTPS) controled

o @ m110 deuhg com von110 6y hp com InteVAMD XB4(HTTPS) controlied
bo ) o trton ing hg com Ranium 6432(HTTPS) controlied

1+ choose an actien Y@ By, Copy With Assignments...

Ut Assign Node to Hode Group...
Found 4 Elements. L Assign Policies | Policy Groups...

7 Move to layout group...
%3 Assign Categories...

% Update Assignments...

¥ Execute Task..
¥ install Agent...
¥ Deinstall Agent...

The (De)Install screen appears. Select Install type as De-installation and click Preinstall
Check.

Operations . 2
0D vonager B i X
Agministration UL o i e B

Edit~ Browsev ServerConfiguration~ Find~ Analyse~ Deployment~ Tasks+ Integrations v

(De)Install Agent

Properties

et

Noges

Piease do not use the browser BACK button, while dtng. To Qut the editor, use the CANCEL button.

Preinstall Check

Messages

Enter the SYSTEM password for the node and click Install on selected Nodes.

Operations .
A Manager /ﬂ\ E x

omu
Agministration UL ©

Edit~ Browsev Server Configuration~ Find~ Analyse~ Deployment~ Tasks~ Integrations~  Servers~

(De)Install Agent

Properties

[sciectJiogerame ——— IPAadress UschineTiwe [etworklyps |Methoa [Sms_[Comment _lrorce?_User [Passwora
= kronos ind hp cem 1514523588 HP Aha(RTTPS) in standard passwidrequired ok {more & roat

Please do not use the browser BACK bution, while edéing. Te qui the edtor, use the CANCEL button.

Install on selected Modes

This uninstalls the agent’s software on the Managed Node and displays the following
message:
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Operations P
D Manager (3] ’/\

L. - Home =2 Admin Help
Administration Ul

Browse~  Server Configuration~ Find ~ Deployment~ Tasks~ Int

All Nodes = ~ o ~

Operation install of nedeflayout group initiated successfully.

Instaliations are running asynchrenously. Review the status of pending installations at the linked page below. Initial
installation takes too long, please refer to the Configuration Guide to reduce the TIMEOUT of the installation script.

5. Check the log file for remote de-installation status To do so, follow these steps:.

a. Inthe Operations Administration Ul windows, go to Deployment —>Installation
Jobs.

Operations Ve
A Manager (] X

- . Home: oMU Server Admin Help
Administration Ul

Edit~ Browse~ Server Configuration~ Find~ Analyse~ Deployment~ Tasks~ Integrations ~

Deploy Configuration...

HPOM for UNIX Configuration =~ o - Deploy Server Policies
ApantfDilnstalinting
Ohject Banks ‘ Installation Jobs

All Objects e ——
Pending Certificate Requests

Server Configuration
Flexible Management Configuration

Object Banks

™ Node Bank

b. The Agent Installation Jobs screen appears. Open the node specific XML file and
check the de-installation status.

Operations
(D] Manager

Administration Ul

Agent Installation Logs

Details jobs w

Found 1 Elements

! Name + Status Exit code
i e oAl 2+ 00K ) 0

L]
O ¢
‘t jC"ccse an action v|m

Found 1 Elements

1.4 Agent Processes on HTTPS Managed Nodes

The Operations Manger Agent is comprised of several processes that handle sub-tasks such as
transmitting messages and monitoring threshold values on a node. The agent supports a library
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of APIs that interact with various processes to give developers access to the capabilities of the
agent.

¢ Message Agent

The Message agent receives messages from log file encapsulator, monitor agent and message
interceptor and forwards the messages to the management server.

*  Monitor Agent

Monitor agent checks the values it finds against predefined thresholds and if a threshold is
exceeded, a message is generated and forwarded to message agent.

e Action Agent

Agents support the execution of various actions (automatic and user-initiated). Actions are
defined in the message policies that are installed on the agent.

*  Message Interceptor
The message interceptor intercepts messages written to the Message Interceptor queue.
¢ Log File Encapsulator

The log file encapsulator scans log files for messages or patterns. It forwards the scanned
and filtered messages to the message agent.

¢ Control Daemon
The Control Daemon starts, stops, and controls other agent processes.
¢ Communication Broker

The communication broker acts as a proxy and provides a central point of entry to the
managed node for all applications on that managed node.

¢ Configuration and Deployment process

It is used for deployment of policies, instrumentation and so on, on the managed node.

1.5 APIs and Libraries
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How to compile and link an application program using OpenView Agent Message and Monitor
APIs?

* Programs calling APIs must include a call to the OVO$VMS_INITIALIZE routine before
calling an API routine. Application program must check for successful execution of
OVO$VMS_INITIALIZE from its return status. If this check is not done and
OVO$VMS_INITIALIZE fails, application program may display an error indicating that
some of the files in the directory structure cannot be found.

For example, Internal error: Cannot open message catalog
/opt/0V/1ib/nls/C/opcagt.cat

*  The program must be linked against the shared image OVO$SLIBOPC_R.EXE. You can do
this by including the following line in an options file, SYS$SHARE : OVOSLIBOPC R/SHARE.
¢  The program must be run from the SYSTEM ACCOUNT.

OVOS$VMS INITIALIZE ()
Int OVOSVMS INITIALIZE()

Parameters
None
Description
This routine does the initialization that is required on the managed node
It defines SYS$POSIX ROOT . It must be called before any opc API

calls are made.

Return Values
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SS$ NORMAL : Normal Successful completion

SS$_ NOLOGNAM : OpenView agents are not installed on the node

SS$ EXLNMQUOTA : Unable to create SYS$POSIX ROOT logical due to insufficient quota
SS$_INSFMEM : Unable to create SYS$POSIX ROOT logical insufficient dynamic memory
opcmsg ()

#include opcapi.h

int opcmsg (

const int severity, /* in */

const char * application, /* in */
const char object, /* in */
const char msg_text, /* in */
const char msg_group, /* in */
const char nodename, /* in */

)i

*
*
*
*

Parameters

severity Severity level of the new message.
application Application of the message source.
object Object of the message source.

msg_text Message text.

msg_group Message group.

nodename Name of the node originating the message.

Description
Use the function opcmsg() to send a message, created on the managed
node, to the management server.

Return Values

OPC_ERR OK: OK

OPC_ERR_APPL REQUIRED: attribute OPCDATA APPLICATION not set
OPC_ERR _OBJ REQUIRED: attribute OPCDATA OBJECT not set
OPC_ERR_TEXT REQUIRED: attribute OPCDATA MSGTEXT not set

OPC _ERR INVAL SEVERITY: set severity invalid

OPC _ERR MISC NOT ALLOWED: message group ‘misc.’ not allowed
OPC_ERR _NO_MEMORY: out of memory

opcmon ()

#include opcapi.h

int opcmon (

const char *objname, /* in */

const double monval /* in */

)i

Parameters

objname Name of the monitored object.

monval Actual value of the monitored object.

Description
Use the function opcmon() to send a monitor value, created on the
managed node, to its management server.

Return Values

OPC_ERR_OK: OK

OPC_ERR_OBJNAME REQUIRED: objname is NULL
OPC_ERR _NO AGENT: agent is not running
OPC_ERR NO MEMORY: out of memory

Sample Program

This is a sample program TEST.C to send a message from managed node to the management
server (15.14.23.11).

#include<stdio.h>
#include<opcapi.h>

1.5 APIs and Libraries
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extern Int OVOSVMS INITIALIZE();

int main ()

{

const int severity = 64;

const char * application="app";

const char * object="obj";/* in */

const char * msg text="MYOPCMSG: Testing with sample program"; /* in */
const char msg_group="Test"; /* in */

const char nodename="15.14.23.11"; /* in */

* Xk

int status;

status = OVOS$SVMS INITIALIZE() ;

if (! (status & 1) )
return (status);
status = opcmsg (severity, application, object, msg text, msg group, nodename) ;

printf ("opcmsg is called and the status is %d\n", status);

}
To run the TEST.C program, follow these steps:

1. Compile TEST.C CC /INCLUDE=OVO$SPOSIX ROOT: [OPT.OV.INCLUDE] TEST.C
2. Use TEST.OPT for linking.

$ type TEST.OPT

$ SYS$SSHARE:OVOSLIBOPC R/SHARE
3. Link TEST

$ link TEST, TEST.OPT/OPT

4. $run TEST.EXE
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1.6 HP Encourages Your Comments

HP welcomes your comments on this document.

Send comments to the following address:

openvmsdoc@hp.com
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